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Section 1.

Importing data
Before exploring how to analyze and visualize your data, this section describes the
various ways of importing data files into SoilFluxPro.

Importing data directly from an LI-8100A
SoilFluxPro can read data files directly from an LI-8100A Automated Soil CO2 Flux
System. To begin the import process, click File and Acquire from the toolbar. For
Ethernet connection, select Ethernet and enter the IP address. For RS-232 serial connection, select RS-232 and select the correct comm port. Lastly, Click Connect To
LI-8100.

A list of files on the instrument will open. Ensure the Internal Storage option is
selected above the file menu.
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Note: the list of files can be refreshed by choosing Refresh File List.

You can also control the LI-8100A pump directly from SoilFluxPro by selecting
Stop Pump. Select the file(s) to download from the instrument, ensure the destination directory is correct, and click Download. Progress can be viewed at the bottom of the dialog.
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Click Done to close the Acquire Dialog. To open your file, follow the instructions
in Opening a data file below.

Opening a data file
To open a file, click File and select Open. Use the Select file(s) to read dialog box to
navigate to the desired directory and select the file(s) to be opened. Select Open to
open the files in the Summary View.
This process is the same for .json files from the Smart Chamber, LI-6800 6800-09
Soil Chamber, and .81x files from the LI-8100A system.

Opening a data file
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The observations and variables will open in the Summary View, which is presented
beneath the Toolbar in the SoilFluxPro interface. Note the Action Log underneath
the main window view. The Action Log shows the history of each action taken during the SoilFluxPro session.

Opening multiple files
You can also select multiple files from the Open dialog box. Use ctrl + click to
select individual files or shift + click to select a range. If multiple files are selected
when you click Open, you are given a choice of combining them all into one view
or keeping them separate.
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When multiple files are combined, each observation retains its original Item#,
which indicates the order of the observation as read from each original file.

The LI-8100 data file format
LI-8100 files consist of lines of tab-delimited text that constitute one or more observations. An Observation consists of the header + n raw records + 3 summary
records + the footer. A single observation is illustrated as follows:

The LI-8100 data file format
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Header: The lines from "LI-8100" through "Labels_01."
Raw Records: A record of Type = 1 indicates a raw record. These represent meas-

ured data from the time the chamber starts to close to the time when the chamber
starts to open.
Summary Records: A record of Type = 2, 3, or 4 indicates a summary record. Each

observation has one summary record of each type.
Footer : The results of the analysis, including flux values. The footer won't be
present for files logged with the Compute Flux option off. However, SoilFluxPro

will regenerate the footer.

Observation type
The first item in each measurement record is the Type.
Type
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Description
-1

Warning record

1

Raw record
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Type

Description
2

Initial value (Regressed from first 10 seconds of
ETime >= 0 data))

3

Mean value (of ETime >= 0 data)

4

Range value (of ETime >= 0 data)

Footer
The footer contains the calculations for an observation. SoilFluxPro adds multiple
flux capability, and these computations add some items to the columns found in
the footer.

In the example above there is one extra column [CH4]_ppm and two extra rows
(GasColumnID and Dilution). This indicates that an extra flux computation was
done, using an imported column, and it used the water measurement H2 O of the
LI-8100A for the dilution correction.
Computing a flux for V1 would be done if a second gas analyzer is connected to the
LI-8100A, with a linearized analog output being fed into channel V1. The flux for
CO2 , without a dilution correction in this case, lets you see the impact of evaporation when you neglect it. In this example, the flux was reduced to 2.78 from

Footer
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3.25. When a dilution correction is done (the V1 example), you can pick the quantity used for the water measurement, and the multiplier to use to convert that reading into mol/mol. In this case, we used the data in the H2 O column (units are
mmol/mol), along with a multiplier of 0.001.

Smart Chamber and LI-6800 data files
Smart Chamber and LI-6800 soil chamber .json files are imported into SoilFluxPro
and converted into the same LI-8100 data file format. The only difference for these
files is how Instrument Name appears in the Header:

LI-8100/A continuous measurements
LI-8100 continuous measurement data files consist of lines of comma-delimited
text as illustrated below:
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Importing columns from trace gas analyzers
Data collected and stored in a separate file by a LI-COR Trace Gas Analyzer integrated into a LI-8100A system, or a non-LI-COR gas analyzer running in parallel
with the Smart Chamber or LI-8100A can be imported into SoilFluxPro and fluxes
can computed from it. This column import routine adds selected columns to any
observation from data extracted from a separate gas analyzer file based on time
stamp. For each row, an external record is found (or interpolated if necessary).
To perform the column import routine, click the Import tool bar button to launch
the Import Data Columns dialog and select the file format of the source file(s) to be
imported. In this example, data from an LGR gas analyzer will be imported.

Importing columns from trace gas analyzers
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Second, click Add Files... to launch a file explorer to add the source file(s) to the
source list.

After selecting a source file, the label line and first observation line from the first
file in the source list will be visible (A). The expected format for the type of file
chosen in the File Format drop-down will be displayed (B). OK means that the data
file being imported matches the expected file. Error means the expected type wasn't
found. Lastly, the list of available data column found in the source file, when
parsed according to the expected formats, are visible (C).
Check the desired column labels to import. Note that column(s) used for time and
date are shown, but are not checkable. Click OK.
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Once the columns are imported, you can view them in the Summary View. Observations that contain imported columns are denoted with an asterisk ( * ) in the
Item# column:

Now, when you update the displayed variables, the imported columns will be available under the Meas tab (see Changing displayed variables on page 2-1).

Importing columns from trace gas analyzers
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When you launch the Recompute dialog, you can now add flux computations
based on the imported columns. See Recomputing observations on page 2-16 for
details.

The new variables are also visible under the Add a Chart option (see Charts and
graphs with SoilFluxPro on page 2-29).
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Using SoilFluxPro Software
With your data successfully loaded into SoilFluxPro, you are now ready to dive into
the analysis and visualization features of the software. From this point on, the
instructions generally apply the same whether you are using data from a Smart
Chamber, LI-8100A, or LI-6800 6800-09 Soil Chamber.

Changing displayed variables
The Items displayed in the Main View dialog is used any time that the list of
SoilFluxPro variables displayed in the Summary View needs to be changed.
To launch this dialog, click on the Display icon from the toolbar. The variables
already being shown in the main view are listed in the Items to be included column
on the right-hand of the window.

Using SoilFluxPro
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To add or remove variables, simply click and drag variables between columns.

Items in the right-hand column can also be dragged vertically to adjust the order in
which they appear (left-to-right) in the Summary View.

2-2
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Note that the variables are divided into 4 lists: Header (Hdr), Footer (Ftr), Measured
(Meas), and Miscellaneous(Misc). For more information about the structure of LI8100A files and variable definitions, see SoilFluxPro definitions on page 2-50.

Preferences
The toolbar appearance can be adjusted by selecting Preferences under the File
menu.

Preferences
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Observation details
To see the details for an observation, double click on that observation in the Summary View. Double clicking opens a new window with five tabs that provide various details about that observation. This view also updates whenever the observation
itself is changed (i.e., is recomputed). Alternatively, click on the Show Details button in the toolbar when the desired observation is highlighted.

As Read is a read-only text view of the observation as it was last read from a file. Current is an editable view of the observation in its current state. Measurements shows
raw and summary records in tabular format. Recompute allows you to recompute
an observation. Fit#1 Cdry represents the curve fit window and is named after the

variable used to fit the curve. In this case, Cdry.

Current
The Current tab shows the observation in text form, including any changes from
recomputations, column transformations, etc. This view is editable, and if changes
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are made, you can select Keep to apply the changes. These changes will then be
reflected in the Summary View. Alternatively, select Cancel to reject the change(s).
Similarly, Revert to Original will undo all changes and revert to the "as-read" state
of the file.

Warnings and messages
Warnings can be generated by the LI-8100 during the measurement. These are
stored in records whose Type value is -1, were put into the file at the time measurements were taken, and typically say something about a measurement condition,
such as high humidity, or the measurement was restarted, etc. In addition,
SoilFluxPro can generate messages at the time an observation is read. The list of
possible messages are shown below.

Observation details
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SoilFluxPro Message

Explanation

File name: missing from header

The label 'File Name:' was not found, but
subsequent records were.

ERROR: Failed to find measured data
labels

The line that identifies measured columns
"Type Etime Date..." are missing.

Old version. Updating format.

The original file was in an older format.

Adjusting dead band and Crv_Domain...

All or party of the observation's footer is
missing.

Warning: Chamber never closed?

Elapsed times never reached values >0.

Summary Records and Footer not found

The file ended without any summary records
or footer.

Footer not found

No footer was found in the file.

Measurements
The Measurements tab shows measurement details in two views: Text and Surface.
The Text tab shows all of the raw records for the selected observation in tabular text
format. The IV, mean, and range can be found by scrolling to the bottom of the
window.

For Continuous measurements that have GPS data, the Surface tab allows spectrographs and contours to be plotted on the surface of your choice. The Continuous
measurement dialog box appears as follows.

2-6

Using SoilFluxPro

Section 2. Using SoilFluxPro Software

1 Z: Select which data column to plot.
2 Min: and Max: Select the minimum and maximum values for the intensity scale.
3 Grid# : Choose the number of grid lines to be used in each dimension.
4 R/G/B: Determine the color map transition points.
5 Contours: Adjust the number of contour intervals between Min and Max. Adjusting the number of
contours changes the resulting contour spacing in units of plotted variable (circled).
6 Spectrogram: Choose whether the spectrogram is plotted in degrees (latitude/longitude) or relative meters.
The Clone button will make a standalone window out of the surface graph and controls. The cloned window retains all the controls except being able to change the
variable that is plotted. The window is also autonomous from the SoilFluxPro observation or its Detail window that created it. If you delete the source observation from
a view, the detail window also goes away, but not this cloned view. Using clones
lets you compare multiple values for the same observation.

Observation details
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Recompute
The Recompute tab in the Detailed View provides a mechanism to recompute just
the target observation. The interface is very similar to that provided in the Recompute Observations section; the only difference is that from here, the recomputation
is focused on one particular observation.
For details on recomputation, see Recomputing observations on page 2-16.

Fit
The Fit tab provides a closer look at the exponential and linear fits for an observation.
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Observation details
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Changing Start/Stop times
Click and drag the green start (left vertical) line, or the red stop (right vertical) line.
When you release the mouse button, the data between the lines are linearly and
exponentially fit, and the results shown in the grid above the chart.

Instead of clicking and dragging, use manual controls ( 1) to manually adjust start
and stop times. Dismiss your changes with Revert and return the bar to the original location or apply your changes with Keep ( 2). Note that the recalculated flux
will be reflected at the top of the window.

Manually set C0
Usually, C0 , the starting value of Cdry, is determined from the IV value of Cdry.
You can manually override this by unchecking the Manually Set Co check box, and
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clicking and dragging the blue horizontal line to the desired value. This normally
is not necessary, but is available if needed.

Start/Stop guidance
The Guidance tab provides some automated tools for assessing start and stop times.
The Start Times plot shows flux as a function of start time (given the current stop
time).

The Stop Times plot shows flux as a function of stop time (given the current start
time).

Observation details
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The Slope Analysis shows the slope of an exponential fit of data in a moving band
between the current start and stop times. In general, you try to work in the region
where this changes linearly with CO2 .
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Managing observations
SoilFluxPro allows for more advanced management of observations in addition to
Changing displayed variables on page 2-1 in the Summary View.

Move observations between views
Selected observations in the Summary View can be copied, cut, and pasted. Observations are selected by clicking on them, at which point the Cut, Copy, Paste, and
Delete options become available in the toolbar (or under the Edit menu). Note that
ctrl + click selects multiple observations, and shift + click allows you to drag your
cursor to select a range of observations.

Managing observations
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Observations can be copied and pasted into a different file. Note that the observations that are copied and pasted retain their original Item#.

Create an empty view
Sometimes it is useful to create a new, empty view to provide a destination for
observations that you will paste in from other views. Creating a new view by selecting New from the toolbar (or from the File menu).
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Copy observations into the empty view using the procedure described in the preceding step. The file will be named unnamed by default, and can be changed by saving the file (see Saving a file on page 2-49).

Sort observations
To sort observations by column, click the column header by which you want to
sort. First, enable sorting by right clicking the content area in the Summary View
and selecting Allow sorting:

Click to sort, and click again to sort in the opposite direction.

Managing observations
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Recomputing observations
To recompute a computation, click on the Recompute icon in the toolbar (or from
the Edit menu). In the Recompute Dialog, select the item(s) you wish to change. In
the example below, we are changing the Offset (soil collar height parameter),
which changes total system volume, and therefore, changes the flux calculation.

Modified variables are automatically entered in red text. If you wish to redo the
Curve Fit or set the Start Time and Stop Times the same, you can check the appropriate boxes in the Flux Calculations portion of the Recompute Dialog.

2-16
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Click Ok and the fluxes will be recomputed. The results will be displayed in a new
window. From this window, the recomputed results can be saved or copied to the
clipboard for pasting into other programs.

Navigating the recompute dialog window

Recomputing observations
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1 Change Constants: Modify a constant used in the flux calculation. Modifying a constant will
change the total system volume, and therefore, the flux.
2 Special: Specify the column to use for chamber temperature and recompute the summary records.
Recomputing summary records is only necessary if raw records were eliminated from the observation.
3 Gas column label: Redo the Cdry vs Etime curve fit.
4 Start Time, Stop Time, and Max Iterations : Adjust these parameters for the curve fit and adjust
the dilution correction. For the gas column Cdry, dilution correction cannot be applied through
the recompute dialog, since it has already been corrected for dilution.
5 Flux @ target: Compute a targeted flux. See Recomputing observations on page 2-16 below.
6 Add fluxes of additional gases: See Recomputing observations on page 2-16 below.

Compute targeted flux
The LI-8100A and Smart Chamber compute fluxes at the concentration present
when the chamber is closed. SoilFluxPro supports additional flux computation at
other targets based on the slope of the exponential fit of Cdry vs. Etime. To compute
the rate of change of Cdry at a particular target concentration C t, we first solve the
exponential fit expression for time tt such that
,

2-1

since
2-2
and
2-3
Therefore, the rate of change of Cdry at time tt is
2-4
The targeted flux is computed using this slope. The target can be a user-entered
value ( Flux @ target = in the recompute dialog), and the flux at this value is
Flux@Target. SoilFluxPro also computes the minimum Cdry value during chamber
closing (MinCO2), and the flux at the that target value (Flux@Min).
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Fluxes of additional gases
The LI-8100A computes fluxes for Cdry, the water-corrected CO2 concentration.
You can add additional fluxes for other gases, such as those recorded during the LI8100A measurement cycle (H2 O).
From the Recompute Dialog, select the plus (+) button to add an additional flux
computation. Then specify the column label for the data to be used for this gas. If
you had methane data logged, then you would use that. In this figure, we’re using
the H2 O column to compute a water vapor flux.

If the data need to be corrected for water vapor (a), specify the column to use for
water vapor (typically H2 O). In addition, you must specify how to convert the water
data in that column into units of mol/mol. If you used H2 O, which is in mmol/mol, the multiplier would be 0.001. You can also specify a targeted flux value (b).
Click OK and the recomputed water vapor flux will be presented in a new window.

Recomputing observations
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Curve fitting details
SoilFluxPro fits measured variables Cdry vs. Etime in two ways: the traditional linear fit, and the theoretically more correct exponential fit. For variable information,
see SoilFluxPro definitions on page 2-50.

Linear fit
Dilution-corrected CO2 (C ) is plotted against time in seconds (t ) and fit by linear
regression
2-5
where slope m is available as Lin_dCdry/dt. Offset b is not available. The correlation
coefficient of this fit is available as Lin_R2. The CO2 flux based on this rate is available as Lin Flux.

Exponential fit
Dilution-corrected CO2 (C) is plotted against time in seconds (t) and fit by a nonlinear regression
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2-6
where C0 is the starting concentration, and is known (Type 2 value of Cdry). It is
also the theoretical concentration when t = t0. The nonlinear regression solves for
C∞, t0 , and a, which are available as Exp_Cx, Exp_a, and Exp_t0, respectively. The
correlation coefficient of the fit is Exp_R2, the slope at t = t0 is Exp_dCdry/dt, the
standard error of the slope is Exp_SE, the CO2 flux based on this slope is Exp Flux,
and the coefficient of variation for the flux (in %) is given as Exp_FluxCV.
The data sets are the same for both fits, and is some subset of the raw records.
There is a dead band of user-defined length to allow for complete mixing in the
just closed chamber. The LI-8100 uses all of the raw records after the start time /
deadband, but SoilFluxPro allows you to shorten this by specifying a stop time.
How much data you fit is available as Crv_Domain of the number of seconds, and
Crv_#Smp for the number of data points.
Exp_Iter reports the number of iterations that the nonlinear regression took, which
typically is less than 5. If the regression takes the maximum number of iterations
(Exp_MaxIter - set via Recompute)and still hasn’t converged, then the normalized
sums of the squares of the residuals are compared (Lin_SSN and Exp_SSN) to see
which gave the better fit. CrvFitStatus reports the result as Lin or Exp. Exp means
the nonlinear fit had lower residuals than the linear fit, and Lin means the linear fit
was better. Whenever Lin is reported, note that the nonlinear coefficients are set as
follows, based on the linear fit:
2-7
2-8
2-9
Lin usually indicates something strange with the data, such as a kink in the time

series of Cdry, which is not uncommon in gusty conditions with a less than perfect
chamber vent design.

Recomputing observations
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Transforming columns
The measured columns of data can be mathematically transformed using one of
the following:
2-10
2-11
2-12
2-13
2-14
2-15
where Z are the values in the column to be transformed, a, b, and c are user-entered
constants, and X and Y are also column values (can be same as Z), but can also be
any other value in the observation.
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To transform columns, select Transform from the toolbar (or from the Edit /
Column / Transform menu path). This will launch the Data Column Transform Dialog. Use this dialog to select the transformation and column, the source column(s)
or values, the constants, and the format for writing the results.

The above-mentioned formulas can be chosen from the Transform: Z= drop-down,
as well as four auxiliary sensor-specific transformation formulas (see Soil moisture
on page 2-25 and Soil temperature on page 2-25).
The following example demonstrates how to replace the Tcham column with an
average of temperatures in columns T2 and T3. The Preview button applies the
transform to the first file in the potential list and shows the results in a new window. It does not change the observational data.

Transforming columns
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Navigating the Data Column Transform Dialog

1 Transform: Z=
Select the desired formula.
2 Z=
Select the Z value (the column to be transformed).
3 X= , Y=
Select the X and Y columns and specify whether all or a specific range of values
will be used. Note: X and (if needed) Y can be columns or any other value from the
observed measurements. If X or Y is not a column, then the single value is used for
all column values.
4 Z format
Enter the constants and select the type format for the new Z value (Sig Digits, Fixed
Point, or Scientific).

2-24
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From the Transformation Preview window, the preview data can be saved in its
own file or copied to the clipboard for pasting into another program. In the original Data Column Transform Dialog, selecting OK will update the observational
data in the original dataset.

Soil moisture
There are three built-in soil moisture transformations. Decagon_EC-5 uses a 3rd
order polynomial, and the two DeltaT_ML3 transforms use a 6th order polynomial.
Coefficients shown below.
Name

a

b

c

d

e

f

g

Decagon EC-5

-0.612

1.16

-0.314

-

-

-

-

DeltaT ML3
(Mineral)

-0.071

0.735

0.75

-8.759

21.838

21.998

8.097

DeltaT ML3
(Organic)

-0.039

0.802

0.819

-9.556

23.823

23.997

8.833

Soil temperature
The 8150-203 Thermistor option provides the following transformation:

Transforming columns

2-25

Section 2. Using SoilFluxPro Software

2-16
where
2-17
and a = 1.1259 × 10−3 , b = 2.3459 × 10−4 , and c = 8.6329 × 10−8 .
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Computing statistics
SoilFluxPro offers simple functions to calculate summary statistics for your data.
First, select Statistics from the toolbar (or from the View menu) to launch the Generate Statistics... dialog.

The default option is to compute summary statistics for the columns currently displayed in the Summary View (to learn how to update the displayed variables see
Changing displayed variables on page 2-1). Select OK to generate the statistics.

Computing statistics
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A new window will open where the statistics can be saved and/or copied to the clipboard for pasting into other applications.

You can also generate statistical results for select columns of interest by clicking
Define... from the Generate Statistics... dialog. Click and drag column names
between the windows to select variables for the custom output.
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Charts and graphs with SoilFluxPro
SoilFluxPro supports a variety of charting and graphing features. Here, basic charting, grouping plotted data, and updating chart parameters is explored.

Add a chart
To add a basic chart, select Add Chart from the toolbar (or from the View menu).

Charts and graphs with SoilFluxPro
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Select the plus (+) sign to add a vertical axis. When the axis information is populated, choose a variable from the <nothing> menu. Additional settings and parameter settings can be selected from the unlabeled drop-down menu to the right of
the variable and from the Axis, Symbol, and Style drop-down menus.
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Select a horizontal axis from the Bottom Axis menu. The variable choices are
presented in the same drop-down menu as in the preceding step.

Note: Footer variables also have a secondary selection, although it is usually 1.
If you have added additional flux computations, this secondary selection is how you
access them. Select Ok and the chart will be produced.

Charts and graphs with SoilFluxPro
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Alternatively, a pre-defined graph can be selected from the Favorites menu in the
Chart Setup dialog.

Grouping plotted data
The Sample Multiplex file, which is available in SoilFluxPro is used to demonstrate
grouping. To open this file, navigate to File / Open Sample / SampleMultiplex.81x).
Next, in the Chart Setup dialog, after choosing axis variables, click on the box
under the Group By header.

Under the Data Grouping Setup drop-down menu, select Observation. Click Ok.
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You will be returned to the Chart Setup dialog. In this dialog, select a location from
the Legend drop-down menu, and again click Ok to generate the chart.

When grouped by observation, each observation appears in a different color and as
a separate entry in the legend.

Charts and graphs with SoilFluxPro
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Grouping by test
Grouping can also occur via one or more tests. In the next example, we examine
Port#, used in multiplexed configurations with the LI-8150 muiltplexer. We treat
this variable as an integer and combine data sets with similar port numbers
together, naming them Port=.
First, launch the Chart Setup dialog and create a vertical axis with Exp_Flux as the
main variable.
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Select Group By to launch the Data Grouping Setup dialog. Use the drop-down
menu to select Group by test(s) below:

Charts and graphs with SoilFluxPro
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Next, click add to launch the Grouping Dialog. Complete the form as follows.

1 Group Variable G=: Choose Port# from the list of Header variables.
2 Interpret as: Choose to represent Port# as an integer.
3 The test: Set the conditions for the test grouping. In this case, we want to group the variable G
(Port#) by the integer representation as part of set Z. Z represents the set of members, which can
be found in the main view under Port#.
4 where Z=: Set the Z values for the test. In this case, Z = {1, 2, 3, 4} for Port#1 - Port#4, respectively.
5 Include in group named: Rename the group as Port=*. Add the asterisk to include the Z value in
the group label (where the legend will appear in the graph).
Select OK. You will be returned to the original Data Grouping Setup dialog. Select
the grouping that was just created, and click OK.
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Charts and graphs with SoilFluxPro
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Lastly, choose the bottom axis (Date), Legend location, and Chart Title, and click Ok
to create the graph.

Setting the color sequence
The sequence of colors used in charts is automatic, but you can modify the
sequence using the Color Sequence dialog in the Chart Setup window. Select Color
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Sequence... to open this dialog. Click and drag the entries vertically to adjust their

position in the color sequence.

Note: under the Options drop-down menu, you can make your order the new
default or restore the color sequence back to the factory default.

Charts and graphs with SoilFluxPro
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To pick a new color to add to the list, select the plus (+) sign. To edit the color of
an existing item, double click the item. Both of these actions will launch the Pick a
Color dialog. From here you can select a custom color. Click Ok to confirm.
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Creating a .KML file for Google Earth
If GPS data is contained in the observation, a .KML file can be created for visualization in Google Earth. Begin by selecting the Map option from the File menu to
launch the Export .KML File Dialog.

Check the observations to be included.
Note: this dialog will only display observations that contain latitude and lon-

gitude data. By default, all observations that contain latitude and longitude data
will be checked.

Creating a .KML file for Google Earth
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Next, select which sorts of markers you wish to have drawn. The Markers to
draw... window list is user definable. To edit a definition, highlight it and click the
View/Edit Details button.

Lastly, select how the data should be grouped ( none, by Observation, by Marker , or
by Marker & Merge Observations) Ensure that the View in Google Earth radio box is
checked, and select Ok. You will be prompted to save your file.

Viewing your .KML file in Google Earth
In order to view the .KML files generated by SoilFluxPro, Google Earth must be
installed locally on your computer. Once installed, launch Google Earth, and select
Open... from the File menu. Locate your .KML file in the directory to which you
saved in the preceding step, and select Open. The observations and markers you
selected in the Export .KML Dialog window will be displayed.
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Creating a .KML file for Google Earth
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Export .KML File Dialog options
Here, we explore each option individually. First, single marker (merged observations) showing average location of all observations.
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Second, place a marker at each observation (de-select Merge Observations in the
drop-down).

Creating a .KML file for Google Earth
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Third, mark each observation with a 3D column with height proportional to flux.

Once the SampleSurvey.81x and Flux columns arrows are expanded, there's a check
box for each column. By selecting Group by Observation in the Export .XML File Dialog (instead of Group by Marker ) and selecting the Markers at each location option,
there is a unique folder for each marker and a unique check box for each location
and marker.
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Lastly, for continuous measurements (for example, the SampleMapper.csv file
included in SoilFluxPro), you can view the path of the measurement. The 3D path
has a height (m) that is computed from the CO2 at each point -360.

Creating a .KML file for Google Earth
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Exporting data
Summary-style data (one observation per row) can be written to a text file for input
into spreadsheet, text-editing, or other statistical analysis applications. To export
data:
1 Select Export from the File menu.

2 Select the fields to export. These can be the same as the Summary View or you can define a different set. To export the same variables that are displayed in the Summary View, select Ok
from the export dialog with the Same as View radio button checked.
In the next dialog, the results can be saved as a text file or copied to the clipboard
for pasting into other applications.
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3 To export a different set of variables, select Define... from the Export from <filename> dialog box. Click and drag items from the list on the left to the empty list on the right. This will
define a new set of variables to export. Select Ok and the observations with defined variables
will appear in the Export from <filename> dialog box.

Saving a file
Files from SoilFluxPro can be exported in a variety of formats, including the .81x,
a LI-COR file type, and comma-separated-value (.csv) type for export into Microsoft
Excel or another statistical analysis software.

Saving a file
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To save the file currently being viewed in the Summary View, select Save from the
File menu. Navigate the Save as dialog box to select the desired destination. Click
Save to save the file.

File suffixes
You can choose or type any file suffix you want (.81x, .csv, .txt, .junk, etc). If you do
not indicate a file suffix, SoilFluxPro will default to the tab-delimited .81x file type.

File delimiters
The Save as dialog box also determines what delimiter is used when the observations are written. Note that SoilFluxPro can read files with any combination of
continuous or chamber measurements with tab, comma, or semicolon delimiters.
Delimiters must be consistent within an observation but can be different from one
observation to the next within a file. When SoilFluxPro writes files, however, it will
use a consistent delimiter throughout the file.

SoilFluxPro definitions
SoilFluxPro classifies variables into four types: Header , Measured, Footer , and Miscellaneous.
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Header variables
Label

Description

LI-8100

5 hexidecimal values giving the size of the
header, label, raw data, summary data, and
footer. (This is no longer used by SoilFluxPro, as
of version 4.0)

File Name

The original file name (as stored on the LI-8100
or Smart Chamber) is preserved by SoilFluxPro,
regardless of how you may rename the
Windows files that contain this data, or cut and
paste observations.

Instrument Name

Instrument Name

Serial Number

Instrument Serial Number

Software

Version of the embedded code in the
instrument. If the file has been stored by
SoilFluxPro, this field will also contain the
SoilFlux- Pro version.

Comment

User entered at time of data collection.

Obs#

Observation number.

Port#

Multiplexer port number (0 if not using a
multiplexer)

Label

User entered at time of data collection.

Observation Length

The original observation length.

Observation Delay

Wait time between observations. (Renamed in
version 3 to Prepurge.

Pre-Purge

Wait time before observations (named
Observation Delay in v.2).

Post-Purge

Wait time after observations (new in version 3).

IRGA Averaging

Averaging time for the gas analyzer.

Chamber

Model identifier for the chamber used.

TSource

Which channel to use for temperature for flux
computations.

Flow8100

Pump setting in the LI-8100 box.

SoilFluxPro definitions

2-51

Section 2. Using SoilFluxPro Software

Label

Description

FlowMux

Pump setting in the multiplexer box.

Tmux

Multiplexer temperature at start of observation.

Virga

Volume of the IRGA (cm3 )

Vmux

Volume of the multiplexer (if used) (cm3 )

Vext

Volume of extension tubing (cm3 )

Vcham

Volume of the chamber (cm3 )

Offset

Offset (cm) used in volume calculation.

Area

Exposed soil area (cm2)

Total

Total volume (cm3 )

V1 Info

Information on how the voltage channel is
configured: Multiplexer channel, slope, offset,
etc.

V2 Info

Information on how the voltage channel is
configured: Multiplexer channel, slope, offset,
etc.

V3 Info

Information on how the voltage channel is
configured: Multiplexer channel, slope, offset,
etc.

V4 Info

Information on how the voltage channel is
configured: Multiplexer channel, slope, offset,
etc.

T1 Info

Thermocouple type information.

T2 Info

Thermocouple type information.

T3 Info

Thermocouple type information.

T4 Info

Thermocouple type information.

Labels01

Number of columns in the raw data section

Measured variables
Summary statistics of measured variables are identified by the column label, and a
prefix of IV, Mean, or Range. Thus, for example IV Cdry means the Type 2 value of
the Cdry column, and Range Etime means the Type 4 value of the Etime column.
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Footer variables
Label

Description

CrvFitStatus

Curve fit solution. “Exp” means the exponential
fit was better than the linear fit (Exp_SSN < Lin_
SSN). “Lin” means the linear fit was still better
after the maximum number of iterations, and the
nonlinear coefficients have therefore been
derived from linear fit.

Exp Flux

Flux computed from Exponential Fit.

Exp_FluxCV

Coefficient of variance (%) of Exp Flux

Exp_dCdry/dt

Slope of the Exponential Fit at time to.

Exp_R2

Correlation coefficient for Exponential Fit.

Exp_SSN

Normalized sum of squares of residuals for
Exponential Fit.

Exp_SE

Standard error (%) of the Exponential Fit.

Exp_a

The a term in the Exponential Fit.

Exp_Cx

The term C∞ in the Exponential Fit.

Exp_Co

The Co term in the Exponential Fit. Usually the
IV value of Cdry, but if followed by *, indicates it
has been manually set. See Manually Set Co.

Exp_t0

The to term in the Exponential Fit.

Exp_Iter

Number of iterations used in the Exponential Fit.

Exp_MaxIter

Maximum number of iterations allowed for the
Exponential Fit. This is fixed to 10 in the LI8100, but can be adjusted in SoilFlux- Pro.

Lin Flux

Flux computed from Linear Fit.

Lin_FluxCV

Coefficient of variable (%) of Lin Flux

Lin dCdry/dt

Slope of the Linear Fit.

Lin_R2

Correlation coefficient for the Linear Fit.

Lin_SSN

Normalized sum of squares of residuals for
Linear Fit

Lin_SE

Standard error (%) of the Linear Fit.

SoilFluxPro definitions

2-53

Section 2. Using SoilFluxPro Software

Label

Description

Crv_Domain

Time span (s) used in the curve fit.

Crv_#Smp

Number of data points used for curve fitting.

Dead Band

Time (s) after the chamber closes that are
skipped by the analysis, in the latest
(re-)computation

TimeClosing

Time (s) it took the chamber to close.

The values below are not part of an LI-8100 data file as output by the instrument. They
are, however, added to the footer of files saved by SoilFluxPro.
GasColumnID

The column label for which flux is computed.
The first one will always be Cdry.

Dilution

The column label used for the H2O
measurements if a dilution correction is applied
to the GasColumnID flux computation. When
computing flux for Cdry, this is none, since
dilution is already accounted for in Cdry. If a
column label is specified, it will be followed by a
decimal value, that represents what was used to
convert the value in the water column to units of
mol/mol.

Target

See: Compute Targeted Flux.

Flux@Target

Flux at Target (Compute Targeted Flux).

MinCO2

Minimum CO2 during chamber closing.

Flux@Min

Flux at MnCO2 (Compute Targeted Flux).

Miscellaneous variables
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Description

Item#

When a file is read, observations are assigned
values starting with 1. They retain this number
throughout their life loaded in SoilFlux- Pro, even
if observations are sorted, copy-pasted, etc. This
value is not retained when a view is written to a
file; when that file is read, Item# values are again
assigned based on the order observations are
read.
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Label

Description

Type

'Cham’ if a chamber measurement, or ‘Cont’ if a
continuous measurement.

#Msgs

The number of Warnings and Messages.
Warnings are -1 TYPE records found in the data.
Messages may be generated when Soil- FluxPro
reads the file.

#Raw

Number of Type 1 records in the observation.

#Gasses

Number of gasses for which flux computations
have been done. That is, the number of data
columns in the footer. See Version 3.2 Footer.

ObsDateTime

Equivalent to the Date value of the record having
ETime = 0.

ObsDOY

Day of the Year (fractional) of ObsDateTime.

ObsDecHr

Decimal hour of the day of ObsDateTime.

HasGPS?

Yes if there are GPS columns (at least Latitude
and Longitude) in the raw and summary data.

SoilFluxPro definitions
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